MailEnable Connector for Microsoft Outlook

Version 2.61

This guide describes the installation and functionality of the MailEnable Connector for Microsoft Outlook.

Features

The MailEnable Connector for Microsoft Outlook has the following features:

- Full integration of email, appointments, tasks and address book
- Server side file management and integration with My Files on web mail
- Connect to other users resources
- Configure permissions for folders for other users
- Access the global address directory
- Set out of office message
- Offline support
- Support for SSL connections to the server

Requirements

It is recommended that the latest version of the MailEnable server is used, as these will have the latest improvements to performance and features. For the client application, you can use the following:

- Microsoft Outlook 2003 (with Office SP3)
- Microsoft Outlook 2007
- Microsoft Outlook 2010 (32bit and 64bit versions)
- Microsoft Outlook 2013 (32bit and 64bit versions)
- Microsoft Outlook 2016 (32bit and 64bit versions)

Installation

Close Microsoft Outlook and run the installation application for the connector.

Upgrading

Once installed the connector will detect new product updates that are released on the MailEnable website. This check can be disabled under the account settings, under the Troubleshooting page, by disabling the Automatically check for software updates option. The plugin checks for new updates when Outlook is started.

Server Configuration

The MailEnable connector communicates to the MailEnable server via the IMAP and SMTP services. A default installation would require the client machine to access the server over ports 143 and 25, although this is configurable. If SSL is being used, the client port configuration must match the server SSL port configuration. It is important that the outbound SMTP connection from Outlook connect directly to the MailEnable server. Without a direct connection, Sent Items are not saved to the server.

Creating an Account

Adding an account to an existing profile in Outlook 2007:

1. Select Account Settings from the Tools menu.
2. Select the New... link to create a new account.
3. Select Other and the MailEnable Server option, then select Next.
4. You can now configure the account as per the steps in Configuring an Account.

Adding an account to an existing profile in Outlook 2010:

1. Select the File menu item and click the Add Account button under the Account Information heading.
2. Select the Manually configure server settings of additional server types option, then select Next.
3. Select Other and the MailEnable Server option, then select Next.
4. You can now configure the account as per the steps in Configuring an Account.

Adding an account to an existing profile in Outlook 2013/2016:

1. Select the File menu item and click the Add Account button under the Account Information heading.
2. Select the Manual setup or additional server types option, then select Next.
3. Select Other and the MailEnable Server option, then select Next.
4. You can now configure the account as per the steps in Configuring an Account.

Configuring an Account

You can now configure the settings for connecting and accessing the MailEnable Server. For simple account configuration you only need to fill out the data on the General tab.
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Email Address</strong></td>
<td>The email address that will be used to send the email.</td>
</tr>
<tr>
<td><strong>Password</strong></td>
<td>The mailbox password.</td>
</tr>
<tr>
<td><strong>Resolve</strong></td>
<td>This button can be clicked in order to have the connector try to auto-fill the rest of the account details. The email address will be used to determine the rest of the settings.</td>
</tr>
<tr>
<td><strong>Server Address</strong></td>
<td>The domain or the IP address of the server running MailEnable.</td>
</tr>
<tr>
<td><strong>User Name</strong></td>
<td>The mailbox name or the full mailbox@postoffice for the mailbox to log into.</td>
</tr>
<tr>
<td><strong>Your Name</strong></td>
<td>This is the friendly name which is show on the emails being send, normally the first name and surname.</td>
</tr>
<tr>
<td><strong>Account Description</strong></td>
<td>A name to identify the mailbox, and is the name Outlook displays when listing the account.</td>
</tr>
<tr>
<td><strong>Enable advanced configuration</strong></td>
<td>When enabled, this will show other configuration tab pages where more advanced options can be configured.</td>
</tr>
</tbody>
</table>

The Mailbox tab allows more advanced options with the mailbox connections to be set:
**Option** | **Description**
---|---
**Server Address** | The domain or the IP address of the server running MailEnable.  
**Port Number** | The port that the connector will connect to on the server. The connector needs to connect to the IMAP service running on the MailEnable server, so this would normally be 143. For SSL this is normally 993.
**Use SSL** | If SSL is configured on the IMAP service then you are able to enable this.
**User Name** | The mailbox name or the full mailbox@postoffice for the mailbox to log into.
**Password** | The mailbox password.
**Mailbox** | This is the mailbox name.
**Resource Connections** | Clicking this will enable you to connect to any shared server resources. Any resources that you are able to connect to will be listed in a dialog which is shown.
**Enable public folders** | If public folders are enabled on the server then you are able to have this shown in a folder in your account.
**Enable server hosted file access** | This shows the My Files folder on the server, so you are able to manage your hosted files.

The Outbound tab allows you to configure extra outbound options:
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Sender Name</strong></td>
<td>This is the friendly name which is show on the emails being send, normally the first name and surname.</td>
</tr>
<tr>
<td><strong>Email Address</strong></td>
<td>The email address to send as.</td>
</tr>
<tr>
<td><strong>Reply To Address</strong></td>
<td>The email address to be used as the Reply-To address in the emails sent. Normally this will be the same as the email address.</td>
</tr>
<tr>
<td><strong>Send mail on behalf of another person</strong></td>
<td>This option is select if you want to send email on behalf of someone else. This changes the From address in the email header to be the display name and email address configured here, and uses the sender name and email address as the Sender address in the email header.</td>
</tr>
<tr>
<td><strong>Display Name</strong></td>
<td>The friendly name to be used for the From address when sending on behalf of someone.</td>
</tr>
<tr>
<td><strong>Email Address</strong></td>
<td>The email address to be used for the From address when sending on behalf of someone.</td>
</tr>
<tr>
<td><strong>Use same settings as for mailbox connection</strong></td>
<td>Usually when sending email you would authenticate using the same mailbox details as you are logging in for, so this option would be enabled. If you need to authenticate as another user when sending email you can set the options here. Be aware that these settings determine which mailbox the sent item appears in (i.e. which Sent Items folder to put the message in). If you do not enter the details of a MailEnable server your Sent Items folder will not be populated.</td>
</tr>
<tr>
<td><strong>Server Address</strong></td>
<td>The domain or the IP address of the server running MailEnable.</td>
</tr>
<tr>
<td>-------------------</td>
<td>---------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Port Number</strong></td>
<td>The port number of the SMTP service.</td>
</tr>
<tr>
<td><strong>Use SSL</strong></td>
<td>If SSL is configured on the server for an SMTP port, you can select it here.</td>
</tr>
<tr>
<td><strong>Outbound server requires authentication</strong></td>
<td>If you do not need to authenticate with your outbound SMTP service, you can unselect this option.</td>
</tr>
<tr>
<td><strong>Account Name</strong></td>
<td>The username to authenticate with.</td>
</tr>
<tr>
<td><strong>Password</strong></td>
<td>The password to authenticate with.</td>
</tr>
</tbody>
</table>
The Connection table allows the changing of connection specific options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Update folders at startup</td>
<td>If this is enabled, when Outlook is started the client will check every server folder and sync these with the client. This will slow down opening the account initially, but may help if the mailbox has other messages.</td>
</tr>
<tr>
<td>Download entire messages</td>
<td>If you have a fast link to the mail server (if it was on your local network), then selecting this option will help reduce delays when new messages arrive, as the connector will try to download the full message as soon as it is available. By default, the connector will only download some of the message details until the message is selected.</td>
</tr>
<tr>
<td>Download contents for inactive folders</td>
<td>When you connect to the server it will check every mail folder on the server and download all messages. By default, messages are only synced for a folder when it is selected.</td>
</tr>
</tbody>
</table>
The Troubleshooting tab is used to configure options for diagnosing problems:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Troubleshooting mode</strong></td>
<td>When enabled, more work is done when syncing the client cache with the server content, to make sure they match. This slows down any synchronisation, so only enable if requested to.</td>
</tr>
<tr>
<td><strong>Disable concurrent downloading and synchronisation</strong></td>
<td>This will force the connector to only process one folder at a time. Only enable if instructed to, as it will slow down the synchronisation process.</td>
</tr>
<tr>
<td><strong>Enable logging</strong></td>
<td>The connector has extensive logging, which is designed to help the MailEnable support team to diagnose any issues. Log files can get very large (gigabytes in size if Outlook is left running for a while), so only enable this if instructed to by a MailEnable support person, and make sure you disable when the required logs are generated.</td>
</tr>
<tr>
<td><strong>Logging level</strong></td>
<td>How much information will be logged to the log files. Full Detail will generate large log files.</td>
</tr>
<tr>
<td><strong>New files each session</strong></td>
<td>Whenever Outlook is started with logging turned on, the log file will be overwritten. If you want to keep log files whenever closing and opening Outlook you will need to enable this option.</td>
</tr>
<tr>
<td><strong>Automatically update contact address labels</strong></td>
<td>Updating Outlooks contact labels immediately adds some overhead to the connection, so it is able to be disabled here to improve performance if needed.</td>
</tr>
</tbody>
</table>
**Automatically check for software updates**

When Microsoft Outlook is started, the connector will check to see whether a new version of the connector is available. It is able to then download this for you and start the installation process.

---

**Initial Connection**

When a connection is first made to the mail server by the client connector, all the mailbox contents from the server are copied to the local profile. If you are connecting to a mailbox with a lot of email data, be aware that it can take time to do the initial connection.

**Sent Items Folder**

The Sent Items folder is a special folder that contains your sent messages. In order for this to work correctly, Outlook must send email directly through the MailEnable server. Some proxies may prevent this from working. After installation and configuration of a profile, send a message with Outlook. Then log into webmail and make sure the sent message is visible, and that you also see this in your Outlook sent items folder. If you do see them in both, then the sent items functionality is working.

When an email is sent, the MailEnable server makes a copy of the email and puts it into the mailbox sent items folder on the server. The mailbox is determined by the account used to authenticate for the send. To ensure that your sent items are synchronised to your own mailbox, your outbound settings should match your mailbox settings. If you authenticate with a different username and password for outbound email, then your sent items will be saved into that mailbox rather than your own.

While you are able to copy items out of the Sent Items folder, it will only make a copy of the message, it will not remove it from the folder.

**MailEnable Menu**

The connector adds another toolbar item to Outlook, called **Server**. The toolbar looks like:

![MailEnable Menu](image)

The following menu items can be accessed:

**Update Folders**: Synchronises the list of folders between the client and the server.

**Reset from Server**: Empties the currently selected folder from the client and downloads the contents from the server.

**Out of Office**: Enable or disable and configure your server side out of office message that will be automatically returned to anyone who sends you an email while you are unavailable. This alters the autoresponder contents which are also accessible from webmail. If you have multiple accounts using the connector configured, then this menu will affect the currently selected mailbox.
**Open Resource**: Opens the "Manage Resource Connections" dialog. For details, see the section below titled "Connecting to a shared resource".

**Share Folder**: Opens the sharing dialog for the selected folder so you can share it with other users.

**Remove Orphaned Cached Items**: Only available when in troubleshooting mode, enabled on the "Troubleshooting" tab of the "MailEnable Messaging Service Configuration" dialog. When selected, removes items from the client that have lost their connection with the server. Use if you have a folder that has items duplicated in it (rarely necessary).

**Check Folder for New Messages**: Only available when in troubleshooting mode, performs a synchronisation with the server on the currently selected folder, checking whether it is up to date, and downloading any missing messages, updating changed messages, and removing deleted messages.

**Hide download progress**: This will hide the message box showing the download progress of larger items.

**Sharing Resources**

To share a folder in Outlook to another user, open the properties of that folder by right-clicking on the folder, and selecting **Properties** from the context menu. In the folder properties window that opens, select the **Permissions** tab. Click the **Add** button, and in the dialog that opens, select who you wish to grant access to, and what level of access to afford them. Press the **OK** button to grant the access, and **OK** again to close the folder properties dialog.

Additionally, you can perform the above procedure to grant access to your entire mailbox by right-clicking on the mailbox root and selecting its properties, and proceeding from there in the same fashion as above.

**NOTE**: The **Permissions** tab is provided by the MailEnable Exchange Client Extension or COM add-in. If you do not see this tab, ensure the MailEnable Exchange Client Extension is enabled (see the section below title "Microsoft Outlook Add-ins").

**Connecting to Shared Resource**

If another user has given you permission to access one of their resources, you can connect to it by accessing the "Manage Resource Connections" dialog. There are two ways of accessing this dialog. From the MailEnable menu in Outlook, you can select the **Open Resource** menu option. Alternatively, from the "MailEnable Messaging Service Configuration" dialog for your MailEnable account, enable advanced configuration settings by ticking the box towards the bottom of the main page, and then on the **Mailbox** tab that becomes available, click the **Resource Connections** button.

Once you have the "Manage Resource Connections" dialog, you will see a list of the resources to which you have been granted access. Find the user in the list who owns the resource to which you wish to connect, and add a tick next to their name. Then click the **OK** button on the "Manage Resource connections" dialog, and, if you accessed the dialog from the configuration dialog of the MailEnable account, press the **OK** button on that dialog as well. You will be warned that you should restart Outlook after making changes to resource connections. Click **OK**, and then restart Outlook.

After Outlook restarts, you will have access to an extra store for the user whose resource you connected to. Expand this store to access the other users resources. Note that you access shared resources in the same way that you access your own; in particular, to access special folders such as a shared calendar, you must go to the "Calendar" view in Outlook, and select which calendar you wish to view from the list of available calendars in the navigation panel. The same applies to contacts and tasks.
Appointment Sensitivity
The MailEnable mail server does not have all the permissions levels that would normally be available when using Outlook with Exchange. So currently when you connect to a shared calendar you will not be able to see any appointments that have a sensitivity level of Private, Confidential or Personal.

Accessing Public Folders
To access public folders, begin by accessing the "MailEnable Messaging Service Configuration" dialog for your MailEnable account. Enable the advanced configuration settings by ticking the checkbox towards the bottom of the main page, and then select the Mailbox tab that becomes available. Tick the option for Enable public folders.

You will now have access to the public folders as a separate mail store in Outlook.

Accessing the MailEnable Directory
The MailEnable directory is a global address list, and each postoffice configured under MailEnable has its own one. The directory is managed through the administration program on the server, and users can edit their own entry through webmail. In order to access the directory, click the Address Book toolbar icon in Microsoft Outlook and select “MailEnable Address List” as the address book. You will need to enter some search criteria in order to get results.

Managing Server Side Files
To manage your server hosted files, begin by accessing the "MailEnable Messaging Service Configuration" dialog for your MailEnable account. Enable the advanced configuration settings by ticking the checkbox towards the bottom of the main page, and then select the Mailbox tab that becomes available. Tick the option for Enable server hosted file access.

You will now have access to your server hosted files in a separate mail store called "My Files". You can download the files you have on the server by dragging them to a folder on your computer, or by double-clicking on them in the list. You can also upload files from your computer by dragging them onto the list of files or a folder in your My Files store in Outlook.

Your file store publishing can also be configured from within Outlook, the same as you can do in webmail. To do this, right click on either the mail store “My Files” (if you wish to publish files in the root directory), or right click one of the sub-folders, and select Properties from the context menu. Select the Publishing tab in the window which appears and you can publish the folder via a URL link.

Offline Support
When a connection is not available to the server, you are still able to use Microsoft Outlook to read, reply and to change flags for messages (the message has to have previously been downloaded to Outlook for this to work). You are not able to do folder manipulation or delete messages. Appointments, tasks and contacts can be created and edited. When a server connection is available again, your previous changes will be synchronised with the server.

Server Folder Synchronisation
The mail server does not give notifications of folder changes, such as new folders, or removing folders. So if you remove a folder in webmail while you have an Outlook connector client connected, it will not know the folder has been removed, and it will still be visible. In order to have the client update the folders, go into the account settings and click the Enable advanced configuration checkbox. Then click the Connection tab that
appears and select the Update folders at startup checkbox. This will force Outlook to check the folders on the server when Outlook is opened.

Microsoft Outlook Add-ins

Much of the behaviour provided by the connector is by Outlook add-ins. There are two alternative add-ins, an Exchange Client Extension (not available in Outlook 2010), and a COM add-in. They both provide the same features. If neither add-in is enabled, you will not have the full synchronisation experience. The procedure for checking the state of the add-ins and enabling them varies with different versions of Outlook.

For Outlook 2003:
Select the Tools > Options menu. Click the Other tab in the window that appears, click the Advanced Options button. Select the Add-In Manager button. In the Add-In Manager window that opens, find the "MailEnable" entry and ensure it is ticked to enable it.

For Outlook 2007:
Go to the Tools menu and select the Trust Center. In the list on the left of the "Trust Center" window, select Add-ins. In the drop down list labelled "Manage:" at the bottom of the right hand panel, select Exchange Client Extensions and click the Go button. In the Add-In Manager window that opens, find the "MailEnable" entry and ensure it is ticked to enable it. If it is not visible, then click the Add... button and select the MailEnableMS32.dll file from the Windows system32 directory (normally c:\Windows\system32).

For Outlook 2010/2013/2016:
Go to the File menu and select Options. In the window which appears, select the Add-ins option. In the drop down list labelled "Manage:" at the bottom of the right hand panel, select COM Add-ins and click the Go button. In the "COM Add-Ins" dialog that opens, look for the option MailEnable Connector for Outlook Add-in, and ensure it is ticked to enable it. If it is not visible, then click the Add... button and select the MailEnableMS32.dll file from the Windows system32 directory (normally c:\Windows\system32).

Importing email data

You are able to import email from an existing PST file to a Outlook connector account. Be aware though that when you do this, all the email being imported has to also be uploaded to the server. So importing large mailboxes may take a long time, depending on the clients Internet connection.

Moving Outlook Connector PST files

It is not possible to change the location of a PST file once an account is created with the Outlook connector. There is not a way to configure the location of the PST files, and the connector will always use the Windows APPDATA environment variable to determine where to store the local cache.
Limitations

1. If the server is currently in Turkish regional settings and sharing is configured via webmail, then those shared resources may not be accessible.
2. Empty contact groups created in webmail cannot be seen immediately in Outlook since webmail does not generate the notification of this.
3. As with webmail, My Files cannot be shared as a resource.
4. Messages that have not been downloaded from the server will show only their downloaded size when sorting, not their complete size.
5. In order for Sent Items folder to be synchronised with the server, the client must communicate directly with the server over SMTP.
6. If emails sent are not being copied to the Sent Items folder on the server, then it is likely that Outlook is not talking directly to the server. Antivirus programs (such as Norton's) or similar proxies can block this from occurring since it uses extended SMTP commands to tell the server to copy the sent message to the users Sent Items.
7. The Connector will always try to save messages to the Sent Items folder on the server, even if Outlook is set to not save to Sent Items.
8. Exceptions to recurring appointments are only kept locally to Outlook. They are not shown in webmail, as exceptions are not supported by webmail.
9. Recurring tasks can be created and used in Outlook, but are not synced to the server, as the server does not support recurring tasks.
10. Mark All as Read for folder is not available.
11. Custom special folders are not supported by the connector. So you are unable to create your own calendar, tasks or contact folders using the Connector. This is because the mail server does not support this feature.
12. If you are running a non-English version of Outlook, any secondary Connector accounts, or shares, will have their special folders in English (i.e. you will have Calendar, Tasks, etc. in English).
13. The global directory is only loaded when Outlook starts. So new contacts added to the global directory will not be visible immediately.
14. While you are able to copy items out of the Sent Items folder it will only make a copy of the message, it will not remove it from the folder.
15. Messages copied into the Sent Items folder will not be synced to the server.
16. BCC addresses are not visible for messages in the Sent Items folder.
17. Folders removed from the server in a mailbox (e.g. using webmail) are automatically removed from the Outlook profile if Outlook is running. If Outlook is not running then a user will still be shown that it exists, but if they select it they will be told that it does not exist on the server. Alternatively, there is an option under the account settings under the Connection tab, labelled Update folders at startup. Enabling this will have the folder structure updated when you open Outlook.
18. Folder changes (such as deletions or renaming) in shares are not visible. Currently the only way to update a folder list you are connected to is to remove and add the share again.
19. Outlook rules are not able to be processed unless Outlook is open at the time the message arrives. If you use rules, after loading Outlook run the rules manually.
FAQ

Q. When trying to save a reminder, I get an error indicating that the folder does not support this type of item.
   A. Reminders are only supported on the default store for the profile you are using. If you are using multiple accounts in a profile, you can change the default by using the Mail control panel applet.

Q. I get the following error when logging in “Access to the requested resource was denied. Please verify that you have been granted full access to the resource:”.
   A. This error can indicate that you are logging in with a username and password, but accessing a different mailbox that you don’t have permission to view.

Q. While composing a message with a large attachment, Outlook seems to freeze for a while.
   A. The connector will save a message being composed to the Drafts folder depending on your Outlook settings. Since the Drafts folder is stored on the server, the Connector will be uploading it. You can increase the time before Outlook saves to Drafts in the Outlook options.

Q. Which account are my Draft messages saved to?
   A. If you have multiple MailEnable email accounts configured under the one profile then draft messages will be stored in the default account.